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Mixture Analysis

How to Analyze Mixture Spectra

Purpose

This exercise demonstrates how to perform a mixture analysis using the KnowltAll Informatics System’s Searchlt application.

Objectives

This exercise will teach you:

» How to configure a mixture analysis
» How to interpret the results of a mixture analysis

Background
Training Files Used in This Lesson
C:\Users\Public\Documents\Wiley\KnowlItAl\Samples\Mixture

The spectral analysis of mixtures in experimental data is a challenging task. Manual !
Analysis\IR Examples

separation of spectral components, even when they are known in advance, is a tedious job.

Attempting to do this analysis in an automated fashion creates a whole new level of e Mixture of Two Steroids — ATR-IR.irf
challenges. KnowlItAll Applications Used
This chapter introduces how to use the Searchlt application to perform Mixture Analysis. e Searchlt

e Minelt
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KnowltAll IR and Raman Search Algorithms

A background in the algorithms used by KnowltAll will be beneficial. For IR and Raman spectral comparison, KnowltAll uses the following
algorithms:

Correlation

This is the default algorithm for searching in KnowltAll and it conforms to the industry standard for correlation algorithms. The Correlation algorithm
is similar to the Euclidean Distance algorithm. The difference between the two is in the way the spectra are treated before the comparison. Each
spectrum is mean centered prior to performing the dot product normalization. This approach can improve search results for noisy spectra and
spectra that have baseline issues, particularly with a baseline offset that is the result of a negative spike or chemical noise. It is slightly more time-
consuming than the Euclidean Distance algorithm. The search speed is slower because each spectrum in the database must be mean centered
and then normalized prior to the comparison. The search results that are obtained with the Correlation algorithm are spectrally similar to the
unknown, even if the unknown compound is not in the database. The Correlation algorithm is heavily weighted by peak areas. Broad features are
weighted much more strongly than sharp features. The algorithm is most tolerant to peak shifts and non-linearities in relative band intensities.

Correlation (Classic)

The Correlation algorithm that was found in all versions of KnowltAll prior to KnowltAll 2020 is similar to the Euclidean Distance algorithm.
However, it did not conform to the industry standard for correlation algorithms. Beginning with KnowItAll 2020, the Correlation algorithm does
conform to the industry standard and it is the default algorithm used for searching in KnowItAll. To provide backward compatibility for customers
who want to reproduce prior search results, the previous correlation algorithm is now provided as Correlation (Classic).

Euclidean Distance

The Euclidean Distance algorithm measures the point-to-point differences between a pair of spectra. The results that are obtained with

the Euclidean Distance algorithm are spectrally similar to the unknown, even if the unknown compound is not in the database. This algorithm,

however, can yield degraded search results when the unknown spectrum has a sloping or offset baseline. The Euclidean Distance algorithm is
heavily weighted by peak areas. Broad features are weighted much more strongly than sharp features. This algorithm is most tolerant to peak
shifts and non-linearities in relative band intensities.

First Derivative Euclidean Distance

Use this algorithm to reduce the effects of baseline slope or offset in the unknown. Although search speed is slightly slower than with

the Euclidean Distance algorithm, the First Derivative Euclidean Distance sometimes gives improved search results, especially when the unknown
spectrum is a mixture of two or more compounds. The First Derivative Euclidean Distance algorithm is heavily weighted by changes in slope.
Sharp features are weighted much more strongly than broad features. The algorithm is also very sensitive to peak shifts. Small shifts can make
the algorithm miss a similar result.
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http://help.knowitall.com/mergedProjects/SearchIt/Linked_Topics/Algorithms/algorithm_Euclidean_Distance.htm
http://help.knowitall.com/mergedProjects/SearchIt/Linked_Topics/Optimized_Corrections/algorithm_Euclidean_Distance.htm
http://help.knowitall.com/mergedProjects/SearchIt/Linked_Topics/Optimized_Corrections/algorithm_correlation.htm
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Second Derivative Euclidean Distance Use the Second Derivative Euclidean Distance algorithm to compare the second derivative of a
reference spectrum to that of the query spectrum.

Optimized Corrections: A Breakthrough Technology for Spectral Searching

Spectral searching is one of the most important tools researchers use to classify or identify materials, yet it continues to be plagued by errors and
imperfections. During a spectral search, a sample spectrum is compared to a database of reference spectra. To ensure that an optimal match is
found in the database, spectra can be adjusted to compensate for differences between spectra caused by variability in instruments, accessories,
environmental conditions, and other factors.

According to ASTM's guide on spectral searching?, various algorithms and manual methods exist to adjust spectra to get reasonable match scores
when two compared spectra of the same compound differ for various reasons. While these methods may work in selected cases, subtle
discrepancies such as a shift of the X-axis are very hard to identify and correct manually. The inflexible mathematical algorithms typically
employed do not compensate for these types of errors in spectra that are flawed.

Manual corrections can be made by expert spectroscopists, but those less experienced in spectroscopy are often unaware of how to perform the
necessary corrections on their sample spectrum to achieve the best search result. To address this growing concern, Wiley has introduced
Optimized Corrections, a breakthrough patented technology that performs a computationally complex set of multiple corrections on query and
reference spectra in a search to find the optimal match between the query and each individual reference spectrum. This training guide will
demonstrate how the Optimized Corrections technology yields better matches between query and reference spectra than can be attained using
rigid search algorithms alone or with manual methods to optimize spectra for searching.

Optimized Corrections consider the full spectrum during a selected range(s) search.

1E2310-04 - Standard Guide for Use of Spectral Searching by Curve Matching Algorithms with Data Recorded Using Mid-Infrared Spectroscopy,
2009. ASTM International Web Site. http://www.astm.org/Standards/E2310.htm (accessed March 4, 2015).
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A typical mixture analysis workflow

Action

Result

1 | Start KnowltAll

Navigate to the Data toolbox and open
the Searchlt application.

Check Spectrum, and in the resulting
Open dialog box, navigate to
C:\Users\Public\Documents\Wiley\Kn
owltAlNSamples\Mixture Analysis\IR
Examples

Open Mixture of Two Steroids - ATR-
IR.

Set Search Method to Correlation.

Searchlt
O &

Search Categories

Spectrum FTIR

[1 Spectrum
[ Peaks
[ Structure

[ Property/Name

Search Databases
@® User-Select
O All Compounds

O Pure Compounds

N2 : search Profiles:  <no profile> b

MNumber of components: Search Method:

1 (Single} ~| | Correlation

=l : )

~ | [ZQuerySpectrum is ATR ] Optimized Corrections

EXCLUDE RANGE BAR

Adyanced Settings...

[ Apply Baseline Correction to Query Spectrum

Hit List Size Limit. 50 2| [JAll Hits

Mixture of Two Steroids - ATR X

1] - Mixture of Two Steroids - ATR ‘
075 | I
[
05 | I | ‘l ‘ | ‘ |‘ ,\.
T
J \ I 1|
0.25] . I lhy I [ IJ‘” | .. | | I |‘ Iy ""‘I\\ﬁ,l,
I\ \ VUL W
i | \ \ Y "-‘I'f‘ ,\I il lll“tﬂ | | .
04— — - - T — ~ I
4000 3500 3000 2500 2000 1500 1000 500

Manually Edit Mask Ranges.

Edit Spectrum

Search
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[ Structure

[ Property/Name
Search Databases
@ User-Select

O All Compounds

O Pure Compounds

E Add Al

Selected for Searching:

<

ATR-IR -
ATR-IR -

Action Result
2 | Click on User-Select under Search Searchit
Databases D W *? Search Profiles:  <no profiles 2 E @
Search categories Auwvailable for Searching:
Set Limit to spectral technique to IR. Spectrum ETIR Limit to speciral technique: |IR %
All Marme
[ Spectrum el ATR-IR - Sadtler Controlled & Prescription Drugs 1 - Wiley
. Networks ATR-IR - Sadtler Controlled & Prescription Drugs 2 - Wiley
C“CI.( Add All at the b.Ottom of - Reference | ATR_|5 - Sadtler Cantrolled & Prescription Drugs 3 - Wiley
Avallable for SearChlng menu. [ Peaks - User ATR-IR - Sadtler Controlled & Prescription Drugs 4 - Wiley
- Hit List ATR-IR - Sadtler Flavors & Fragrances - Wiley

Sadtler Inorganics 1 - Wiley
Sadtler Inorganics 2 - Wiley

Add

MName

ATR-IR -
ATR-IR -
ATR-IR -

ATR-IR -
£

Sadtler Controlled & Prescription Drugs 1 - Wiley

Sadtler Controlled & Prescription Drugs 2 - Wiley

Sadtler Controlled & Prescription Drugs 3 - Wiley

Sadtler Controlled 8 Prescription Drugs 4 - Wiley

Select by Browsing...

Mixture of Two Steroids - ATR X

Hit List Size Limit: 30 |5

[ ANl Hits

3 | Click Search.

One component search result returns to the Minelt application.
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Action

Result

ot Related Compounds

A ChamenMSEO® ENMR WG

o DB 21023 Name

Ari

Structure/Properties

4 | Highlight the first hit.

From the Edit menu, select Copy
Active Spectrum.

File Edit View Database HitList MS Tools NMR Tools Wi
Copy Active Spectrum

i'
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Action Result
5 | Go back to Searchlt, — ”
0 & K? © search Profiles:  <no profile> - B
Sear:h Categnries Number of components: Search Method: . .

H 2 (Mixture) ~ | Correlation ~ [] Query Spectrum is ATR Optimized Corrections Advanced Settings...
CI_ICk the Spectrum FTIR button to ””’ - 2 Z
bring up the query spectrum. e

[ Included Components 1= — Mixture of Two Steroids - ATR l
[ Excluded Components 0.8
Update the Number of components to 1
2 (M|Xtu I’e). [ Structure 06 I'
1 A { l ‘ ,
[ Property/Name 04— “\I | ‘ | ’ J ‘r‘ Jq,”
] i ‘ \\ ‘ I
Search Databases 2] |}| l",‘l h I"l \W M\ ““m l\ |\ U‘J/.‘I “-“J‘\h\
® User-Select ] [ VL[V L‘ U ‘\J‘ hl !
o —en ] ) Ayl
O All Compounds. ki o
4000 3500 2000 2500 2000 1500 1000 slo
O Pure Compounds m
Summary [ Apply Baseline Correction to Query Spectrum Manusally Edit Mask Ranges... Edit Spectrum
Hit List Size Limit: 50 [2] CIAll Hits
Mixture of Two Steroids - ATR X
The Included Components and Excluded Components checkboxes show up now.
6 Check the Included Components. Searchit
D W R!? Search Profiles:  <no profile> = E ﬂ
Paste the copied spectrum. Search Categories Il S n s
Spectrum FTIR
Included Components ‘ LM
J"-J- "‘* ||‘ AWML.
[ Excluded Components — ‘-: — — . .
3000 2000 1000
DWW #G35; Ethisterone
[ Structure
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Action Result
7 | Click the Spectrum FTIR button to
bring up the query spectrum. Minelt .
Display Profiles:  <no profile> - B 0= =) B By 4% W2 ' Lookup Compound:
. e [ TN e L A
Click Search. Q'Fﬂl LA ﬂ:.u.l'm' . St MHJLI& AT
- Mixture of Two Steroids - ATR (Corr
- Composite Spectrum (Corrected)
0.75
0.5
025
0:
4000 3500 3000 2500 2000 1500 1000 500

cm™
ATR-R | MS(GO | NMR

Table Plot Related Compounds View
HQl ¥ Ratio  ~ Exclude Co/DE, ID | Name ~| Chemical Structure Spectrum <auto> (IR/ATR-IR)

1 95.48 N.A. Composite Spectrum

DWX #935; Ethisterone
0= ® (Corrected) —)‘L)“JMM
03 () @DDWX 907 Epiandrosterone ,C@:b Mﬂ

N.A. Residual Spectrum

Now we have a good two-component match.

Notes: Each composite spectrum (row 1) is accompanied by the individual component spectra (middle rows) that
comprise the composite, as well as the residual spectrum (last row)—the difference between the query spectrum and
the composite. The composite spectra are ranked by how closely they resemble the query spectrum. A relatively flat
residual spectrum indicates that the software has correctly identified the individual components of the mixture. The
Weight value for each component spectrum indicates how much it contributes to the composite spectrum.
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Action Result

8 | The circle in the Exclude column can
be checked to exclude a component

from consideration. T B oo, Epianrasterant (Conas
0.75—
Check to exclude DWX 907.The 05
Repeat Search button shows up for
user to repeat Mixture Analysis without 0257
considering DWX 907. ol
4000 3500 3000 2500 2000 1500 1000 500
cm™

ATR-IR

Table Plot Related Compounds View

Hal ¥ Ratio ~|Exclude | Co| DE| |

D~ Name ~| Chemical Structure Spectrum <auto> (IR/ATR-IR)

1 95.48 N.A. @ Composite Spectrum ,dﬁjb
DWX #935; Ethisterone
i @ (Corrected) _AU__JWLIN

N.A. Residual Spectrum

{ Repeat Search...
2 9548 NA. @ Composite Spectrum r\F(i:b L b LLAT e

Note: In KnowltAll 2023 release, “Weight” column is labeled as “Ratio” as this value is the ratio of a component
spectrum curve.
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Action Result
9 | Click Repeat Search. The new result does not contain excluded DWX 907.
~ Mixture of Two Steroids - ATR (Corr
= Composite Spectrum (Corrected)
0.75
0.5
0.25
0:
4000 ~ 3800 3600 3400 = 3200 3000 2800 2600 2400 = 2200 = 2000 1800 1600 = 1400 = 1200 1000 = 800 600
cm™
ATR-IR MS (GC) NMR
Table Plot Related Compounds View
HQl ¥|Ratio | Exclude | Co D |ID , | Chemical Structure Spectrum <auto> (IR/ATR-IR) *
DWX #935; Ethisterone
(Corrected) MNWLM
036 (O @vsAa 5052 Epiandrosterone -MM
N.A. Residual Spectrum
T ——————
Notes:
e You do not have to specify Included or Number of components:
Excluded components to perform a e
mixture analysis. You can simply open a ( - re)
spectrum in Searchlt and specify ;{::?t"]
Number of components to a value (Mixture)
larger than 1. 4 (Mixture)
5 (Mixture)
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e You can add Included or Excluded
components from files by clicking the
Add button.

Search Categories
] Spectrum FTIR

Included Compoenents

Excluded Components

Included Components:

|
A ‘! }M}‘(

2000
DWX #935; Ethisterone

Add...

e You can exclude spectrally similar
records.

Excluded Components:

LA L I

b o e s ]
2000
DWX #907; Epiandrosterone

<
[JApply Bas !mage Size: l

Spectrum

Exclude compounds that are similar within a limit of: E

Add...

Delete

One can view the metadata of query
spectrum by

e View > Query Spectrum Info
in Searchlt and

e View > Windows/Tables >
Query Spectrum Info in a
Minelt hit list.

View License Help
Absorbance
% Transmittance
X-Axis Format
Active Peaks
All Peaks

| ~ Standard Toolbar
+ ¥ Spectrum Toolbar
~  Status Bar

: | Query Spectrum Info

>

Ctrl+K
Ctrl+Q
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*  Absorbance

! % Transmittance

Edit Mode

Display Mode >
| Auto Scale Mode >
| X-Axis Format >

Spectrum Overview Pane

1 Peaks >
| Integrals
|
Toolbars >
Windows/Tables >

Implicit Hydrogens
Assignment Information >
v Stereochemistry

1

" 4000 ' 3800 ' 3600

View Database HitList MS Tools NMR Tools Window License Help
Expert Searchit % QC Expert <>Processlt

Lookup Compound:

v Spectrum Pane

¥ Structure/Properties Table
Peak Table
AUC/Integration Table
Coupling Data Table
Search Parameters Table
Search Overview Pane

Alt+6
Alt+3
Alt+2

Alt+5
Alt+7

Query Spectrum Info
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Use Included Components

Action

Result

1 | In the Data toolbox, open the Searchlt
application.

Check Spectrum.

In the resulting Open dialog box,
navigate to
C:\Users\Public\Documents\Wiley\Kn
owltAlNSamples\Mixture Analysis\IR
Examples folder.

Open Mixture of Two Steroids - ATR-
IR.

Set Search Method to Correlation.

Set Number of components to 2
(Mixture).

Searchit
0O & &

Search Presiex:
Search Categories

4 Spectrum FTIR
[ Included Components
[ Excluded Companents
L[ Structure

L1 Property/Name

Search Databases

® User-Select

O All Compounds

<ro pro

- B b+ WL

Mumber of companents: Search Methad:

- WMMM ule

2 (Mixture) ~  Correlation [“1Query Spectrum i ATR

EXCLUDE RANGE BAR

[ Optimized Corrections Advanced Settings...

0.2+

Taubo " 3@00 3600 ' 3400 | 3200 | 3000 | 2800 | 2600 | 2400 | 2200 2000 1800 | 1600 140 | 1200 | 1000 |
cm™

INCLUDE RANGE BAR

[ Apply Baseline Correction to Query Spectrum Manually Edit Mask Ranges... Edit Spectrum

Hit List Size Limit: 30 3 [JANlHits  Display Profiles: |<no profile> Search
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Action Result

2 | Check Included Components. I a2 | "
Search Categories Included Components:

[ Spectrum FTIR
Add the following files from —— L
C:\Users\Public\Documents\Wiley\Kn = "
owltAlNSamples\Mixture Analysis\IR Excluded Componens

Examples\Components folder:

[ Structure [+ ‘M‘@N
e Epiandrosterone ATR-IR 0 Property/Name
e FEthisterone ATR-IR Search Databases
® User-Select
All Compounds

Note: Use the Ctrl key to select multiple
files in the Open dialog box.

Pure Compaund: Jmege Stze [ |

3 | Click Search.

Note: Toggle between different spectra
display modes by selecting available
options from View > Display Mode.
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Action Result
] = Mixture of Two Steroids - ATR (Corr.
1 = Composite Spectrum (Corrected)
0.75+
0.5
0.25+
0
4000 3500 3000 2500 2000 1500 1000 500
cm™
. AmRr | Ms@O LNMR J
Table Plot Related Compounds View
HQl ¥ Ratio | Exclude Co/DE, ID ~, Name .| Spectrum <auto> (IR/ATR-IR) -
1 Composite Spectrum
0.62 ® Ethisterone ATR MMM
0.38 @ Epiandrosterone ATR Mm
N.A. Residual Spectrum
—— ey
In this case, KnowltAll simply returns possible combinations of two provided components without going through a
database search.
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